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Instalacija aplikacije

Prije pokretanja same aplikacije potrebno je izvršiti slijedeće korake:

1. Aplikaciju je potrebno kopirati na putanju C:\SPSS\Projekat06\
2. Zatim je potrebno provjeriti da li su servisi neophodni za rad aplikacije podignuti. To se može uraditi tako što se u Indusoft Web Studio ode na Project->Status... . Na Slici 1. je prikazano koji sve servisi moraju biti startovani. Ukoliko nisu, potrebno je kliknuti na servis koji se mora startovati i zatim kliknuti na Start dugme.
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Slika 1.
3. Nakon toga je potrebno otići u Start->Control Panel->Administrative Tools->Data Sources (ODBC),  (Slika 2.)
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Slika 2.
Potrebno je dodati drivere preko kojih će se ostvariti veza između baza podataka i aplikacije. Koraci za kreiranje potrebnih drivera su slijedeći:
· Za kreiranje novog data source-a najprije treba kliknuti na Add... (Slika 3.)
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Slika 3.

· Klikom na Add... otvorit će se lista drivera od kojih je potrebno odabrati Microsoft Access Driver (*.mdb) te kliknuti na Finish (Slika 4.)
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Slika 4.

· Na slijedećem okviru potrebno je unijeti ime Data Source-a i selektovati bazu sa kojom se želi ostvariti konekcija klikom na dugme Select... (Slika 5.)
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Slika 5.

· Prilikom selektovanja baze potrebno je znati putanju na disku gdje se ona nalazi. U ovom slučaju je to c:\SPSS\Projekat06\Grupa02\ .(Slika 6.)
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Slika 6.
Napomena: Za aplikaciju KDIII-1 potrebno je postaviti 4 Data Sourca, i to 2 za samu aplikaciju KDIII-1 i druga 2 za aplikaciju skladište. Svaka aplikacija traži po 2 Data Source-a zbog problema nastalog  prilikom njihovog kreiranja. Naime, aplikacije nisu u stanju ostvariti konekciju sa bazom ukoliko ne postoji jedna baza sa kojom se ostvaruje samo konekcija i druga konkretna baza u koju se vrši spašavanje vrijednosti (ovo nije uvijek slučaj, ali ovaj način realizacije još nije zakazao). U slučaju aplikacije KDIII-1 baza 0602t_vanjsko.mdb služi samo za uspostavljanje konekcije, dok baza 0602KDIII.mdb služi kao procesna baza. Kod aplikacije skladiste 0602konekcija.mdb služi za uspostavljanje konekcije, a skladiste.mdb kao procesna baza. Nazivi, baze na koje su vezani i putanje do tih baza za sve Data Source-ve se nalaze u slijedećoj tabeli:
	Naziv Data Source-a
	Baza na koju se veže
	Putanja do baze

	0602Konekcija
	0602t_vanjsko.mdb
	C:\SPSS\Projekat06\Grupa02\

	0602bazaT
	0602KDIII.mdb
	C:\SPSS\Projekat06\Grupa02\

	0602Konekcijas
	0602Konekcija.mdb
	C:\SPSS\Projekat06\Grupa02skladiste\

	0602skladiste
	0602Skladiste.mdb
	C:\SPSS\Projekat06\Grupa02skladiste\


Tabela 1. 
· Krajnji izgled liste drivera za access baze je prikazan na slici 7.
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Slika 7.
4. Na istom mjestu se vrši i podešavanje drivera za excel. Koraci su slijedeći:

· Nakon klika na Add... iz liste drivera odabrati Microsoft excel Driver (*.xls) i kliknuti na Finish (Slika 8.)
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Slika 8.

· U Data Source Name upisati naziv i kliknuti na Select Workbook... (Slika 9.) 
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Slika 9. 

· U Select Workbook je potrebno odabrati excel file sa kojim se želi povezati aplikacija. U ovom slučaju to je KDIII.xls koji se nalazi u c:\SPSS\Projekat06\Grupa02\. (Slika 10.)
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Slika 10.

5. Nakon toga je potrebno podesiti IP adresu servera da bi se mogla ostvariti TCP/IP konekcija s njim. Navedeno se nalazi u Indusoft Web Studio Workspace-u pod tabom Comm, u folderu TCP/IP, file-u 1:TCP/IP konekcija->Server IP Address. (Slika 11.)
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Slika 11.
6. Zatim je potrebno podesiti i adresu Data Servera koji omogućava da se aplikaciji pristupi preko web-a odlaskom na Indusoft Web Studio->meni Project->Settings...->tab Web. Kao Data Server IP Address je potrebno unijeti IP adresu računara na kojem se izvršava aplikacija. Nakon toga potrebno je unijeti URL u slijedećem formatu http://IP adresa računara na kojem je WEB server/ (Slika 12.)
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Slika 12.

Računar na kojem su spašene HTML datoteke mora biti Web Server, a računar na kojem se aplikacija izvršava treba imati fiksnu IP adresu. 

WEB Server treba pokrenuti sa putanje c:\SPSS\Projekat06\Grupa02\Web\NTWebServer.exe (Slika 13.)
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Slika 13.
Napomena: Prije pokretanja ovoga Web servera, treba zaustaviti IIS Services (Microsoft
Internet Information Services) koji je po default-u instaliran kod instalacije WIN2K ili

WINXP operativnih sistema (otvorite Control Panel->Administrative Tools->Services->IIS Admin, a zatim pritisnite dugme STOP). 
Nakon ovoga aplikaciji se može pristupiti sa bilo kojeg PC-a u LAN mreži ili sa Interneta (ukoliko se aplikacija izvršava na serveru), kao thin klijent, unoseći u njegov Internet Browser slijedeću adresu:

http:// IP adresa računara na kojem je WEB server /start.html
Pojavit će se prozor za unos imena korisnika i njegove lozinke, koje treba unijeti iz liste

konfigurisanih korisnika (npr. Admin, Admin).

7. U aplikaciji je korišten ICONICS OPC Simulator. Prilikom pokretanja simulatora (Start->All programs->ICONICS OPC Server Simulator->Simulator OPC Server) potrebno je provjeriti da li je u simulatoru otvoren file Toplane.sim koji se nalazi u C:\SPSS\Projekat06\Grupa02\ folderu. Ukoliko nije isti je potrebno otvoriti preko menija File->Open. (Slika 14.)
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Slika 14.

8. Na kraju je potrebno još provjeriti da li se exe verzije programa navedenih u tabeli nalaze na slijedećim putanjama:
	Program
	Putanja

	MSACCESS.EXE
	C:\Program Files\Microsoft Office\Office11\

	WINWORD.EXE
	C:\Program Files\Microsoft Office\Office11\

	EXCEL.EXE
	C:\Program Files\Microsoft Office\Office11\


Tabela 2. Putanje MSOffice programa
Ukoliko se ne nalaze, potrebno je u IWS-ovom Workspace-u otvoriti tab Tasks->Math->10: Putanje (Slika 15.) i u dijelu Expression unijeti putanje do Excel-a, Access-a i Worda pod navodnicima.
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Slika 15.
Opis aplikacije
Cijeli sistem kotlovnice KDIII-1 simuliran u ovoj aplikaciji funkcionira na osnovu informacija o vanjskoj temperaturi zraka. U ovisnosti od nje sistem zagrijava vodu koja cirkuliše kroz njega na određenu temperaturu sa ciljem dobijanja proračunate potrebne izlazne temperature iz kotlovnice. 

Toplane Sarajevo su u stalnoj komunikaciji sa hidrometereološkim zavodom, Sarajevo Gasom, Vodovodom i kanalizacijom te Elektroprivredom jer koriste energente na osnovu kojih pružaju uslugu centralnog grijanja većem dijelu grada i na listi su prioriteta u slučajevima nestašice bilo kojeg od energenata.

Iako je cijeli realni sistem izuzetno stabilan, redovno se održava i vjerovatnoća bilo kakve havarije je jako mala, u ovoj aplikaciji je, radi omogućavanja korisniku da posmatra ponašanje sistema pod određenim uvjetima, data mogućnost izazivanja kvarova na pojedinim elementima gdje ispitivanje ima smisla.

Imajući u vidu izuzetno veliki značaj ovog sistema veoma je važno svesti vjerovatnoću pojave kvara na najmanju moguću stopu i obezbjediti pravovremeno reagovanje na najmanje neregularnosti. S obzirom na složenost sistema i njegovu ovisnost o nestabilnim faktorima, automatsko upravljanje je zastupljeno u velikoj mjeri a procjena iskusnih ljudi koji upravljaju kotlovnicom ima presudnu ulogu. 

Centralni dio sistema je predstavljen na ekranu KDIII-1 koji predstavlja kotlovnicu KDIII-1 sa svim njenim komponentama. 

Kotlovnica je zbog ratnih razaranja rekonstruisana tako da preuzme zadatak zagrijavanja Dobrinje IV i IIIb (prije ih je zagrijavala kotlovnica KDIII-2 koja je u ratu devastirana), tako da vodovi idu ka i od Dobrinje IIIa, Dobrinje V i Dobrinje  IIIb i Dobrinje IV.

Komponente korištene u aplikaciji
Kotlovi

U kotlovnici se nalaze tri kotla za zagrijavanje vode označena kao K1, K2 i K3. Kada su u aktivnom stanju, kotlovi su žute boje a kada su ugašeni kotlovi su sive boje. (Slika 17.)
Kotlovi se aktiviraju klikom na ručicu ON/OFF. Ukoliko su dostupni energenti kotao će se početi zagrijavati. Svaki od kotlova je povezan na gasovodnu mrežu i na rezervoar sa alternativnim gorivom. (Slika 16.)


Alternativno gorivo se koristi samo u slučaju da nestane gasa, pri čemu se automatski zavrće ventil na cijevi za dovod gasa, a odvrće ventil na cijevi za dovod goriva. 
S obzirom na složenost ekrana KDIII-1, sistem za pokretanje kotlova, odabir energenata te praćenje pripadajućih parametara je odvojen u zaseban ekran Kotlovi. (Slika 17.)
Za kotlove se vežu režimi rada koji ovise o vanjskoj temperaturi, što čini osnovu za funcioniranje kotlovnice, a koji će biti objašnjeni nešto kasnije.

Pumpe

Prije ulaza u kotlove se nalaze tri ulazne pumpe označene kao P1’, P2’ i P3’. (Slika 18.) Za sigurno funkcioniranje kotlovnice je neophodno da rade po dvije ulazne i izlazne pumpe. U slučaju kvara na jednoj od aktivnih pumpi P1’ ili P2’, automatski se uključuje rezervna pumpa P3’. Ukoliko iz nekih razloga i rezervna pumpa prestane sa radom, što je malo vjerovatno ali ipak uzeto u obzir, sistem se automatski isključuje, kako bi se izbjeglo veliko opterećenje na jednoj pumpi što bi dovelo do kvara na njoj.
Aktivne pumpe su označene zelenom a neaktivne, odnosno pokvarene, crvenom bojom.
Na izlazu iz sistema se nalaze izlazne pumpe označene kao P1, P2 i P3, od kojih su kao i u slučaju ulaznih pumpi dvije uvijek aktivne a jedna (P3) je rezervna.

Sve pumpe su praćene ventilima koji se nalaze prije i poslije pumpi i rade sinhronizirano sa njima.  Prestanak  rada  neke od pumpi, automatski uzrokuje zatvaranje pripadajućih ventila i obrnuto. Pumpe se pokreću pomoću prekidača koji se nalazi na screenu KDIII-1. Ukoliko je korisnik neku od pumpi zbog simulacije ponašanja sistema stavio van funkcije, što implicira kvar, pritiskom na dugme Popravka pumpi koje se nalazi na ekranu sa alarmima sve pumpe se postavljaju na inicijalno ispravno stanje. 
Dugme restart stavlja kotlovnicu u početno stanje koje pretpostavlja ispravnost svih komponenti i postavljanje potrebnih parametara na zadate vrijednosti.

Razdjeljivači

U kotlovnici postoji sedam razdjeljivača vode označenih od R1 do R7. Njihova funkcija je da obezbjede adekvatnu raspodjelu vode ali i da rasterete pumpe. 

Ventili

Svaka cijev je praćena sa dva ventila koji služe za njenu izolaciju u slučaju nastanka kvara, odnosno njenog pucanja. S obzirom da su proračuni za takve slučajeve veoma složeni i komplicirani, a i vjerovatnoća toga je mala, u aplikaciji nije ostavljena mogućnost izazivanja kvarova na tim ventilima. Ventili takođe reguliraju protok vode kroz sistem. Aktivni ventili su zelene boje, a neaktivni crvene boje. U sistemu postoji više vrsta ventila. Kugl ventili, prestrujni ventili, nepovratni ventili i zaporni ventili su predstavljeni simbolom na Slici 20., dok su automatski ventili za regulaciju miješanja vode po temperaturi predstavljeni simbolom na Slici 21.
Postoji pet automatskih regulacionih ventila za miješanje tople i hladne vode, koji funkcioniraju na osnovu informacija primljenih od senzora temperature. Na njima je moguće izazivati kvarove. Nakon pritiska na dugme Popravka ventila koje se nalazi na ekranu za alarme, kvarovi na svim ventilima se otklanjaju.

Između razdjeljivača R1 i R3 nalazi se rezervna cijev na kojoj su ventili za protok vode zavrnuti osim u slučaju kvara svih 5 ventila za miješanje vode. U tom slučaju se ventili automatski odvrću da bi se pritisak smanjio.

Ekspanzione posude

U kotlovnici se nalaze dvije ekspanzione posude za vodu (Slika 22.), svaka sa kapacitetom od 7 m3. Za njih su vezana tri ventila koji propuštaju vodu u posude, a koji prevashodno služe za reguliranje pritiska. Jedan ventil je rezervni. Drugi ventil se otvara kada pritisak u sistemu iznosi 5,8 bara, a treći ventil se aktivira ukoliko pritisak poraste na 5,9 bara. 

Za ekspanzione posude su vezane dvije pumpe od kojih je jedna rezervna a jedna radna, sa mogućnošću izazivanja kvara i popravke jedne od njih. Kada se pumpa popravi, ponovo se aktivira prva a rezervna se gasi. Pumpe su automatske kao i ventili. Pumpa za regulaciju pritiska se pali kad pritisak u sistemu opadne ispod 5.37 bara radi povećanja pritiska upumpavanjem vode iz ekspanzionih posuda, a gasi se kad se pritisak podigne na 5,915 bara. 
Što se tiče tretiranja problema preljevanja vode iz posuda, to je automatski riješeno i voda u tom slučaju ide u odvode te ne predstavlja opasnost po sistem. Alarm se javlja samo u slučaju nedostatka vode, odnosno dostizanja minimalne potrebne količine vode u posudama.

Funkcioniranje sistema (kotlovnice)
Radi omogućavanja korisniku da posmatra ponašanje sistema pod zadanim uvjetima, klikom na pumpe ili ventile mogu se izazvati kvarovi na pumpama i ventilima za miješanje vode. Takođe, kvarovi se mogu otkloniti pritiskom na dugmad Popravka pumpi i Popravka ventila na ekranu alarmiOnline.

Dugme restart na početnom ekranu vraća vrijednosti svih parametara na inicijalne, definirane vrijednosti: temperatura vode u kotlovima se postavlja na 10°C, nivo vode u ekspanzionim posudama se postavlja na 4000 l, količina alternativnog goriva u rezervoaru je 25000 l, napajanje gasom se uključuje, pritisak u sistemu se postavlja na 5,8 bara, pumpe su neaktivne, nema kvarova u sistemu a otvoreno je svih pet ventila za miješanje vode.  
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Slika 23.
Budući da zagrijavanje kotlova na radnu temperaturu od 98°C traje oko 2 sata što simulaciju čini neadekvatnom za korištenje, uvedena su 2 režima rada: režim zagrijavanja kotlova kod kojeg jedan sat odgovara jednoj minuti i režim rada u realnom vremenu. Nakon zagrijavanja kotlova na 97°C ulazi se u real-time režim rada. Kotlovi mogu dostići maksimalno temperaturu od 100°C, nakon čega se gorionici automatski gase i ostaju isključeni sve dok temperatura ne padne ispod 97°C. Kad se gase kotlovi, dešava se ubrzano hlađenje, pri čemu temperatura u kotlovima i cijevima nikad ne pada ispod 10°C.

Pritiskom na dugme Kotlovi, otvara se ekran u kome se mogu pokretati ili zaustavljati kotlovi, prekidati ili uspostavljati dotok gasa, pratiti temperatura u kotlovima te pratiti potrošnja i stanje energenata. (Slika 24.). 
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Slika 24.

Kotlovnica je direktno povezana na gasovodnu mrežu iz koje se snabdijeva gasom. U slučaju nestašice gasa, prelazi se na upotrebu ekstra lakog lož ulja koje se čuva u rezervoaru i njegova količina se pomno kontroliše. Takođe se prati ukupna potrošnja alternativnog goriva, iz razloga nastojanja da se optimizira potrošnja i smanje gubici. Za gas se prate ukupna i trenutna potrošnja. Korisnik pomoću prekidača može prekinuti dotok gasa. Ako količina alternativnog goriva u rezervoaru dostigne minimalnu vrijednost od 20000 l oglasiće se alarm.
Na ekranu Kotlovi se prikazuje i potreban broj kotlova koji trebaju biti uključeni pri trenutnoj vanjskoj temperaturi zraka. 
Kotlovnica radi u četiri režima rada u zavisnosti od vanjske temperature zraka, kako slijedi: 

· od -20°C do -11°C aktivna su sva tri kotla;
· od -11°C do 6°C aktivna su dva kotla; 

· od 6°C do 12°C aktivan je samo jedan kotao;
· iznad 12°C se gasi kotlovnica (0 aktivnih kotlova).
Režimi rada i regulacija se određuju na osnovu Tabele 3:

	Vanjska temperatura °C
	Temperatura odlazne vode °C
	Temperatura povratne vode °C

	20
	20
	20,0

	19
	23
	21,0

	18
	26
	23,3

	17
	29
	25,0

	16
	32
	27,3

	15
	35
	29,5

	14
	37
	31,2

	13
	40
	33,0

	12
	42
	34,7

	11
	44
	36,0

	10
	46
	37,5

	9
	48
	39,5

	8
	49
	40,4

	7
	51
	42,0

	6
	53
	43,6

	5
	54
	44,4

	4
	56
	46,0

	3
	58
	47,0

	2
	60
	48,2

	1
	62
	49,7

	0
	63
	50,6

	-1
	65
	52,0

	-2
	66
	53,0

	-3
	67
	54,0

	-4
	69
	55,0

	-5
	70
	56,0

	-6
	72
	57,0

	-7
	73
	58,0

	-8
	75
	59,0

	-9
	76
	60,3

	-10
	77
	61,3

	-11
	79
	62,3

	-12
	80
	63,0

	-13
	81
	64,0

	-14
	82
	64,8

	-15
	83
	65,5

	-16
	85
	66,3

	-17
	86
	67,3

	-18
	87
	68,3

	-19
	89
	69,2

	-20
	90
	70


Tabela 3.


Nakon zagrijavanja kotlova na 97°C, pomoću prekidača na ekranu KDIII-1, pokreću se pumpe (Slika 25.). Ukoliko se radi o režimu rada u kojem je vanjska temperatura ispod -5°C, pumpe se trebaju aktivirati bez obzira na kotlove radi sprječavanja smrzavanja vode u cijevima što bi dovelo do pucanja cijevi. 
Pumpe su praćene ventilima koji se otvaraju i zatvaraju u ovisnosti od funkcioniranja pumpi. Prestanak  rada  neke od pumpi, automatski uzrokuje zatvaranje pripadajućih ventila. Ponovno stavljanje pumpe u pogon pokreće automatsko otvaranje odgovarajućih ventila.
U sistemu koji radi uvijek moraju biti aktivne po dvije pumpe na ulazu i izlazu iz sistema. U slučaju kvara na nekoj od aktivnih pumpi, aktivira se rezervna pumpa koja radi do saniranja kvara na pumpi na kojoj je nastao. Ukoliko sa radom zakaže i rezervna pumpa dok još nije saniran kvar, a što je malo vjerovatno, kotlovnica se iz sigurnosnih razloga gasi. 
U sistemu kada su pumpe isključene pritisak je konstantan i iznosi 5,8 bara. Paljenjem pumpi pritisak se reguliše tako da na izlazu iz sistema (kotlovnice) on varira između 5,37 i 5,8 bara. Kretanjem vode kroz sistem cijevi koji vodi do i od korisnika pritisak postepeno opada da bi, pri povratku vode u kotlovnicu, na ulazu iznosio 2,07-2,5 bara.

Ulazne pumpe zatim taj pritisak podižu za oko 1,7 bara. Kretanjem vode kroz kotlove i ventile za mješanje također dolazi do opadanja pritiska za oko 1,3 bara, tako da je funkcija izlaznih pumpi da ga podignu na 5,8 bara. Da bi se ta vrijednost postigla uprkos variranju pritiska na ulazu i u samom sistemu postavljene su pumpe za regulaciju pritiska. Spomenute pumpe se nalaze u ekranu Ekspanzione posude (Slika 26.). Jedna pumpa je rezervna dok se na drugoj može izazivati kvar. Kvar se može otkloniti pritiskom na dugme Popravka pumpi za pritiske koje se nalazi na ekranu sa alarmima.
Ako je pritisak u sistemu ispod 5,36 bara one se aktiviraju sa ciljem stabilizacije pritiska na 5,8 bara. Ukoliko je ulazni pritisak ispod 2,07 bara, to signalizira da je došlo do pucanja vanjskih cijevi i da se stabilizacija pritiska ne može postići ni radom pumpe za regulaciju pritiska. U tom slučaju cijeli sistem se gasi zbog sigurnosti. 
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Slika 26.
Sigurnosne postavke (Security)

Korisnici aplikacije prema svojim pravima mogu pripadati jednoj od dvije grupe korisnika – Admin i Guest. Korisnici sa administratorskim pravima (Slika 27.) mogu pristupiti svakom ekranu i svakoj komandi te imaju privilegiju pisanja i čitanja u bazu i excel tabelu. Oni također mogu dodavati nove korisnike u grupu. 
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Slika 27.
Korisnici koji pripadaju guest grupi (Slika 28.) imaju također pristup svim ekranima unutar aplikacije, međutim, oni nemaju mogućnost upravljanja procesom već samo mogu biti posmatrači. Isto tako oni nemaju prava da vrše unos podataka u excel tabelu i access bazu. 
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Slika 28.
Prava korisnika su podešena imajući u vidu da će korisnici kojima je i namjenjena ova aplikacija biti administratori, dok svi ostali korisnici se smatraju 'posjetiocima' te im se kao takvim ne smije dopustiti da na bilo koji način poremete rad aplikacije ili procesa.

Prilikom pokretanja aplikacije na startnom ekranu (Slika 29.) korisnik se treba prijaviti. Na osnovu username-a i password-a aplikacija određuje kojoj grupi korisnik pripada i automatski mu dodjeljuje pripradajuća prava.
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Slika 29.
Postavke (SystemSettings)

U aplikaciji je moguće promijeniti sistemski datum i vrijeme odlaskom na ekran Podesavanje (Slika 30.). Na istom ekranu je moguće dodati nove korisnike, kao i izbrisati već postojeće korisnike. Navedeno je moguće učiniti samo ukoliko korisnik ima administratorska prava, jer posjetioci nemaju mogućnost da otvore ovaj ekran.
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Slika 30.
Prijevod aplikacije

Prilikom rada sa aplikacijom moguće je odabrati jezik na kojem će biti napisani linkovi, labele i uputstva. Na raspolaganju su Bosanski i Engleski jezik a odabir se vrši klikom na odgovarajuće dugmiće na startnom ekranu.(Slika 31.)
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Slika 31.
Alarmi

S obzirom da je KDIII-1 sistem od velikog značaja za grad, svi alarmi koji se javljaju u toku izvršavanja aplikacije su kritični. Kvar se prijavljuje ispisom alarma ružičastim slovima, alarm za sanirani ali nepotvrđeni kvar se ispisuje svijetlo plavom bojom a potvrđeni alarmi su tamno plave boje. 
Postoje dva ekrana koja se odnose na alarme: Online Alarmi i Historijski alarmi.
Na on-line alarmima se može potvrditi najstariji alarm ili se mogu potvrditi svi alarmi. Moguće je uključivanje/isključivanje zvučnog alarma. Sa ovog ekrana postoji veza na ekran Historijski alarmi.
Na ekranu OnlineAlarmi (Slika 32.) moguće je vidjeti i stanje na lokalnom skladištu kotlovnice KDIII-1, odnosno broj rezervnih pumpi, pumpi za regulaciju pritiska i ventila. Također je moguće vidjeti broj pokvarenih komponenti te klikom na odgovarajuću dugmad (popravka ventila, popravka pumpi, popravka pumpi za pritiske) otkloniti kvarove. Minimalan dozvoljeni broj ventila na lageru je 5, pumpi 6 a pumpi za regulaciju pritiska 2. U slučaju da bilo koja od ovih vrijednosti padne ispod dozvoljene oglasiće se alarm. Također je sa ovog ekrana moguće uspostaviti konekciju na bazu i ažurirati je.
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Slika 32.
Izvještaj o kvarovima pumpi i ventila je moguće kreirati unosom naziva file-a KVAROVI (ili nekog drugog naziva) u polje sa nazivom Izvjestaj. Spomenuti file se može sa istog mjesta i otvoriti.
Postoje nekoliko tipova alarma: 

· alarmi za pad vanjske temperature ispod -5°C, kada treba pokrenuti pumpe i za pad pritiska ispod 5,36 bara;
· alarmi za pad nivoa vode u exp posudama ispod minimalnog od 150 l;
· alarmi za pad nivoa ekstra lakog lož ulja ispod minimalnog 20000 l;
· alarmi za nestanak rezervnih dijelova u lokalnom skladištu;
· alarmi za oglašavanje kvarova na pumpama ili ventilima.
Na ekranu Historijski alarmi (Slika 33.) je, pritiskom na korespondentnu dugmad, moguće izdvojiti alarme koji su vezani za pumpe, ventile, energente, ponašanje pritiska i temperature (dugme p-t) ili odabrati prikaz svih alarma (dugme Svi). Veza sa ekranom Online alarmi se ostvaruje pritiskom na dugme Online alarmi.

Moguće je kretanje kroz historiju alarma pomoću dugmadi sa brojevima od 1 do 12 koja predstavljaju mjesece u godini. Pritiskom na dugme Svi dani odabiru se svi dani u mjesecu za koje želimo prikaz alarma. Korisniku je omogućen direktan unos godine i početnog i krajnjeg datuma za period za koji želi pregledati alarme.

[image: image25.png]Dstum

19.04.2006

13.04.2006 19:47:12  Nestaje ventila na lageru - min ih treba & m
13.04.2006 19:47:12  Nestaje purnpi 2a odrzavanje priiska - min trebaju 2
0 projektu 13.04.2006 19:47:12  Nestaje purnpi za cirkulaciju vode - min ih treba B
| 13.04.200 19:47:12  Nestaje ventila na lageru - min ih treba 5
L 13.04.2006 19:47:12  Nestaje purnpi za cirkulaciju vode - min ih treba 6
Hijerarhija 13.04.2006 19:47:12  Nestaje purnpi 2a odrzavarje priiska - min trebaju 2
13.04.2006 19:47:12  Nestaje purnpi za cirkulaciju vode - min ih treba 13.04.2006 20:01:45
Podesavanje 13.04.2006 19:47:12  Nestaje purnpi za odrzavanje priiska - min trebaju 2 13.04.2006 20:01:45
13.04.2008 19:47:12  Nestaje ventila na lageru - min ih treba 5 13.04.2006 20:01:45
L Aam ] (20070000 1140 Nectevenie e i ek
Trendovi 13.04.2006 21:11:43  Nestaje purnpi 2a odrzavanje priiska - min trebaju 2

13.04.2006 21:11:43  Nestaje purnpi za cirkulaciju vode - min ih treba B

=
KDIII-1 Energenti Onling alarmi God

Pocetni dan: [0

Nazad Krajnji da

nior ]
T

a: 0

alarmi M





Slika 33.

Trendovi
Postoje dvije vrste trendova koji se posmatraju: Online trendovi prate ponašanje parametara u trenutku dok se aplikacija izvršava a Historijski trendovi omogućavaju pregled kretanja vrijednosti parametara u rasponu od 30 dana. 
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Slika 34.

Online alarmi (Slika 34.) prate kretanje vrijednosti vanjske temperature zraka, trenutnih temperatura i pritisaka u sistemu. Na x-osi se nalazi vrijeme (jedinica vremena je tri minute) a na y-osi su vrijednosti posmatranih parametara u svojim dozvoljenim rasponima. 
Trenutne temperature se odnose na vrijednosti temperatura u sva tri kotla, kao i na ulaznu i izlaznu temperaturu iz sistema, čiji se prikaz omogućava pritiskom na korespondentnu dugmad. 

Trenutni pritisak prati ponašanje ulaznog i izlaznog pritiska koji se međusobno razlikuju bojama navedenim u legendi.
Historijski trendovi (Slika 35.) omogućavaju posmatranje ponašanja vanjske temperature, temperatura i pritisaka vezanih za sistem u odabranom proteklom vremenu.

Kretanje kroz historiju trendova vrši se pomoću klika na dugmad ispod grafikona određujući da li se želimo pomjerati (nazad/naprijed) za mjesec, dan, sat, minut ili sekund.

Pored vremena, na x-osama su naznačeni i datumi kada su zabilježene vrijednosti koje se posmatraju.

Na ekranu su prikazani početno vrijeme i datum historijskog trenda.
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Slika 35.
ODBC (Konekcija na Access bazu)
Aplikacija ima mogućnost povezivanja na Access bazu. Prije pokretanja same aplikacije potrebno je postaviti Data Source-ve u Administrative Tools onako kako je to opisano u instalaciji aplikacije, tačka br. 3.
Preko ekrana ODBC (Slika 36.) moguće je vršiti ubacivanje slogova u bazu kao i listanje već unešenih slogova gdje je najprije potrebno kliknuti na dugme Selektuj a zatim se moguće kretati kroz slogove preko dugmića sa strijelicama. Također je moguće selektovani slog izbrisati iz baze pri čemu će se promjena prikazati tek prilikom ponovnog listanja slogova. 
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Slika 36.

U bazi 0602KDIII.mdb (Slika 37.) se čuvaju podaci o stanju na lageru, vanjskoj temperaturi, temperaturama kotlova, ulaznoj i izlaznoj temperaturi KDIII-1, količini potrošenog gasa i alternativnog goriva, količini alternativnog goriva u rezervoaru, ulaznom i izlaznom pritisaku u KDIII-1, nivou vode u ekspanzionim posudama i datumu i vremenu bilježenja tih podataka.
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Slika 37.
DDE (Veza aplikacije i Excela)

Aplikacija KDIII-1 u excel file KDIII.xls spašava podatke o ukupnoj količini potrošenog gasa, ekstra lakog lož ulja (ELLU) koje se koristi kao alternativno gorivo u slučaju nestanka gasa i proizvedene toplote od trenutka startanja rada kotlovnice. Također se spašava i datum i vrijeme bilježenja tih podataka. Da bi se vršilo spašavanje u Excel potrebno je najprije ostvariti konekciju s njim i to klikom na dugme Disconnect/Connect 2 puta (dok status ne promijeni na OK). Oba puta će se pokrenuti  Excel aplikacija sa otvorenim file-om KDIII-1.xls, pri čemu će jedan od njih biti aktivan dok će drugi biti read-only. Ovo je neophodno uraditi jer se nemoguće konektovati na Excel na drugi način (u pitanju je bug u samom IWS software-u). Upisivanje u Excel se može vršiti automatski svaka 2 sata ili na zahtjev korisnika pri čemu korisnik mora prvo selektovati tu opciju a tek zatim kliknuti na dugme Pisi u excel (Slika 38.). Dugme Pocni od pocetka pisati u excel služi da se resetuje brojač redova u Excelu tako da se worksheet popunjava od početka.
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Slika 38.
U samom Excel-u se na osnovu unesenih podataka izračunava količina potrošenog gasa i ELLU-a između svaka dva bilježenja te se računa cijena potrošenog gasa uzimajući cijenu gasa po m3 direktno sa internet stranice http://www.bloomberg.com/markets/commodities/energyprices.html. (Slika 39.)
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Slika 39.
OPC

Aplikacija KDIII-1 je također povezana i sa ICONICS OPC Simulatorom. U OPC simulator je u ovoj aplikaciji korišten za simuliranje promjene vanjske temperature koja u potpunosti određuje način rada kotlovnice. Simulirana temperatura se kreće u rasponu od -20°C do 20°C. Na startnom ekranu (Slika 40.) u njegovom gornjem dijelu se može vidjeti koja je trenutna vrijednost simulirane vanjske temperature i klikom na dugme se ta vrijednost može prenijeti u tag aplikacije. Na osnovu unesene vrijednosti aplikacija će prilagoditi sve parametre vezane za upravljanje kotlovnicom koji ovise o vanjskoj temperaturi.
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Slika 40.

TCP/IP
Aplikacija KDIII-1 preko TCP/IP konekcije razmjenjuje podatke sa aplikacijom Skladište (koja predstavlja glavno skladište rezervnih dijelova za Toplane Sarajevo). Kod obje aplikacije je neophodno da budu podignuti servisi TCP/IP Client Runtime i TCP/IP Server (pogledati 2. korak u uputstvu za instalaciju).
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Slika 41.

Podaci koji se razmjenjuju se tiču rezervnih pumpi, pumpi za regulaciju pritiska i ventila, pri čemu aplkacija KDIII-1 šalje Skladištu podatke o stanju svog lokalnog skladišta i u tom slučaju se KDIII-1 ponaša kao server a Skladište kao klijent, dok aplikacija Skladište šalje podatke o ukupnom broju rezervnih dijelova i pri tom se ona ponaša kao server a KDIII-1 kao klijent (Slika 41.). Na osnovu razmjenjenih podataka moguće je vršiti ažuriranje baze ili naručivanje komponenti.

Aplikacija omogućava da se podaci koje dobija od Skladišta kopiraju u njene tagove tako da u slučaju prekida TCP/IP konekcije ona ima sačuvano najnovije stanje na skladištu.

Aplikacija Skladište (Slika 42.) predstavlja simulaciju promjene stanja na glavnom skladištu Toplana Sarajevo. Ona također ima konekciju sa bazom 0602skladiste.mdb u koju spašava trenutno dostupnu količinu rezervnih dijelova. TCP/IP konekcija sa KDIII-1 joj omogućava ažuriranje vlastitih podataka. U realnosti su ti podaci neophodni da bi se na vrijeme uočilo kojih rezervnih komponenti nedostaje te se na vrijeme prisutpilo nabavci istih.
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Slika 42.

Preko dugmeta  „Help“ dolazi se do ekrana koji, pored tekstualnog help dokumenta, sadrži i kratko uputstvo. Unoseći naziv fajla u formi „t <temperatura u °C>“ (npr . t12 – za temperaturu od 12°C, ili

 t-5°C – za temperaturu od -5°C) dobija se podatak o potrebnom broju aktivnih kotlova (0 do 3) i informacija da li je potrebno pokrenuti pumpe u sistemu da ne bi došlo do leđenja cijevi (ako je t<-5°C pumpe se moraju paliti).
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Slika 43.

Potrebno 2 puta kliknuti da bi se ostvarila konekcija na Excel
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